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Overview 

The Crystal Reports Report Pack for salesforce.com lets you connect to data that you have 
access to in your salesforce.com accounts. You can then use this data to create reports that 
contain charts, cross-tabs, and other features that are available in Crystal Reports. 

This document is made up of the following sections: 

• Overview  

• Data sources in Crystal Reports  

• Prerequisites for installation  

• Connecting to a salesforce.com data source  

• Specifications  

• Configuration  

• Known issues  

• Sample reports  

Data sources in Crystal Reports 

Crystal Reports helps you select data sources and fields by providing easy-to-use functionality 
in the Database Expert and the Field Explorer. Each of these dialog boxes uses the familiar 
Windows tree structure to allow you to navigate through the possible choices. 

The Database Expert provides an integrated tree view of all data sources you can use with 
Crystal Reports. In the Database Expert, you can select the salesforce.com data source 
folder. 

Use the Field Explorer to insert, modify or delete fields on the Design and Preview tabs of 
Crystal Reports. To see the Field Explorer, select the Field Explorer command from the View 
menu. 

Prerequisites for installation 

The Salesforce.com Driver 3.0 only works with Crystal Reports XI R2. For users of Crystal 
Reports XI, please upgrade to Crystal Reports XI R2.: 
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Connecting to a salesforce.com data source 

When you install the Crystal Reports Report Pack for salesforce.com, you can use the Crystal 
Reports Salesforce.com driver to create a report. First, you have to select a data source from 
the list of Available Data Sources on the Data tab of the Database Expert. 

Note:  See the Business Objects white paper “Connecting to Salesforce.com Data with Crystal Reports” for a 

list of best practices and suggestions for maximizing the performance of the Crystal Reports Salesforce.com 

driver. The white paper is available at the following URL: www.crystalreports.com/salesforce.  

� To select a database 

1. In the Database Expert dialog box, expand the Create New Connection folder and then expand 
the SalesForce subfolder. 

The program prompts you for your salesforce.com login credentials. 

2. Specify the server, and enter your salesforce.com user ID and password. 

Tip:  This is the same user ID and password that you use to access your account on 
salesforce.com. 

The Crystal Reports Salesforce.com driver supports Developer Edition accounts, 
Enterprise Edition accounts, Unlimited Edition accounts, and Professional Edition 
accounts. 

Users who want to access Salesforce Sandbox can change the server value to 
test.salesforce.com. The default value of the server is www.salesforce.com. 

3. Once you are connected, expand the Tables or Stored procedures node of the connection to see a 
list of tables.  You can also double click on the “Add Command” node in order to enter a custom 
SOQL query. 

The list of tables displays the objects that you have access to in your salesforce.com 
account. 

The list of stored procedures displays the native salesforce.com reports that you have 
access to in your salesforce.com account.  

4. Select a table or stored procedure and click the > arrow to add it to the Selected Tables list, and 
then click OK. 

The Design tab of the Report Designer appears. 

5. Click Field Explorer on the Standard toolbar. 

The Field Explorer dialog box appears. 

Note:  Depending on how it appeared when you last used Crystal Reports, the Field Explorer 
dialog box might be docked or in floating mode. 
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Once you can see the tables available in your salesforce.com data source, you can use them 
to create a Crystal report in the same way you’d use any other data source. For more 
information about creating Crystal reports, see the Crystal Reports User’s Guide. 

Note:  You can combine other data sources with your salesforce.com data (for example, you can link 
tables from an Enterprise Resource Planning (ERP) system or from a Supply-Chain Management 
(SCM) system). 

Specifications 

• You can use Crystal reports that you create with the Crystal Reports Salesforce.com driver in 
BusinessObjects Enterprise. 

• You can view, publish, refresh, and schedule a report that uses the Crystal Reports Salesforce.com 
driver in BusinessObjects Enterprise. 

• You can view and refresh a report that uses the Crystal Reports Salesforce.com driver in 
LiveOffice. 

• The driver is available only in English. 

• The driver is available only on the Windows operating system. 

Configuration 

• You can configure the JVMMaxHeap, JVMMinHeap, CacheRowSetSize, QueryBatchSize, 
SocketTimeout, and UseCacheJoin values in the CRConfig.xml file. 

Note:   

• For Crystal Reports XI R2, the CRConfig.xml file is installed by default in the \Program 

Files\Business Objects\common\3.5\java directory. 

• JVMMaxHeap is the maximum value of Java virtual memory, while JVMMinHeap is the 
minimum value of Java virtual memory. 

If you want to fetch large amount of data, you can increase these values to improve the 
ability. The default values of JVMMaxHeap and JVMMaxHeap are 64000000 and 
32000000 bytes. 

• CacheRowSetSize is the batch size that the program uses to transfer data between the Java and 
C++ stack. The default value is 2000. Usually, you will not need to change this value.. 



  Crystal Reports Report Pack for salesforce.com 3.0  

   

 

  Crystal Reports Report Pack for salesforce.com 3.0  5  

  

• QueryBatchSize is the value to adjust the chunk size returned from salesforce.com to gain the best 
performance. The recommended value is 2000 which is the default value. 

• SocketTimeout is a time-out value for the HTTP socket response. You can specify the time-out 
value in milliseconds. The following is an example: 

<SForce> 
<CacheRowSetSize>2000</CacheRowSetSize> 
<QueryBatchSize>2000</QueryBatchSize> 
<SocketTimeout>60000</SocketTimeout> 
</SForce> 

You may come across socket time-outs in the salesforce.com system. Socket time-outs 
occur when the client terminates a connection after a specified period of time. By default, 
this period of time is 600seconds. 

When a socket time-out occurs, the following message appears: 

java.net.SocketTimeoutException: Read timed out 

 

The socket time-out error occurs randomly. To workaround this error, you can refresh your reports 
again or you may want to simply increase the socket time-out value. 

 

• Salesforce.com driver is supposed to work with JDK 1.4. Please make sure your Java directory is 
pointed JDK 1.4.  

 
In CRConfig.XML, the tag JavaDir specifies where your Java Virtual Machine is 
installed.  
 

<JavaDir>C:\Program Files\Business Objects\j2sdk1.4.2_08\bin</JavaDir> 

Known issues 

• In Crystal Reports, a table name might be different from what you see in saleforce.com, if the 
object name and label name of this object are different. Crystal Reports uses the object name, 
while salesforce.com uses the label name for display. 

• In Crystal Reports, the name of fields might be different from what you see in salesforce.com, if 
the field name and label name of the field are different. Crystal Reports used the field name, while 
salesforce.com uses the label name for display. If you want to see exact field-name information in 
saleforce.com, select “show description” or “show both” from File>Options>Database. 
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• If the dataset to be retrieved exceeds the JVM size that you configured in CRConfig.xml, an error 
occurs. To avoid the error, you can increase the JVM size. For more information, see 
JVMMaxHeap and JVMMinHeap in Configuration. 

• If a field is a reference data type, the relative ID value is retrieved. If you want to show more 
meaningful information for this field, you can create a link between relative tables. 

• The currency type symbol, such as $, is not shown for a currency field. If multi-currency support is 
enabled for your organization and you want to know the type, you can add the CurrencyISOCode 
field to your report. 

• If you have large amount of data, it is recommended that you use BusinessObjects Enterprise to 
schedule reports and view the scheduled instances, instead of viewing on demand. 

• Salesforce.com has a server-side query cursor time-out. When linking very large objects together, 
you may see this error: 

The query locator has timed out on the server side. 

In this case, if the object you are linking to is much larger than the object you are linking 
from, we suggest reversing the link and trying again. 

• The partner WSDL interface for salesforce.com does not support a trial account logon; therefore, 
the WSDL interface does not work with a trial account. 

• When reporting from stored procedures (native Salesforce.com reports), columns that contain 
Boolean values are represented as Strings in Crystal Reports.  The value in the Crystal Report will 
either be “0” or “1” if the actual value is false or true, respectively. 

• When using stored procedures, all numerical values will be represented with decimal places in 
Crystal Reports, regardless of whether the salesforce.com value has decimal places or not.  

• At report design time, when adding a stored procedure to the list of selected tables, the Crystal 
Reports user interface may freeze while the native report is exported from the Salesforce.com 
server.   

• When refreshing a report based on stored procedures, if the “Verify Stored Procedures on First 
Refresh” option is not enabled, the user will not be notified if a column was added to the native 
Salesforce.com report.  In the case that a column was deleted from the native report, the user will 
receive an error message but the database will not be updated.  It is recommended that users enable 
this option (located in the Database tab of the Options window). 

• Some Salesforce.com reports must be customized before they can be imported into Crystal 
Reports.  These reports will still be visible to the user as stored procedures; however, when the 
stored procedure is added to the Selected Tables list, the user will receive an error message stating 
that they must customize the report using the Salesforce.com website.  
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Installation guidance  

• If there is a previous version of the Crystal Reports Report Pack for salesforce.com installed 
on your computer, please uninstall it before installing the latest version.  

• The “repair” feature of the installer does not work well in some scenarios. The workaround is 
to uninstall the salesforce.com driver and reinstall it.  

• Uninstalling the Salesforce.com Driver 3.0 will break the XML Driver if a customer is using 
XIR2 RTM or XIR2 SP1. After uninstalling the Salesforce.com Driver, users have to repair 

(reinstall) Crystal Reports. But then the XML Driver will potentially not work.  The 
workaround is to install SFDC driver again. 

• Install CR XIR2 (RTM or SP1) and the Salesforce.com Driver 3.0 and then install BOE 
(RTM or SP1) on top of them or in the order that BOE + Salesforce.com driver + CR, both 
the Salesforce.com driver and the XML driver will be potentially broken. The workaround is 
to uninstall the Salesforce.com Driver v3.0 first and install the Salesforce.com driver V3.0 
again. 

Sample reports 

The Crystal Reports Report Pack for salesforce.com comes with a number of sample reports. 
The samples are developed with the demo@winter06.com account. You might use your own 
account to adjust the reports to better fit your needs. In particular, the demo@winter06.com 
account has products associated with opportunities. By default, salesforce.com does not 
create this association. You can add a product to an opportunity by going into the opportunity, 
choosing the Standard Pricebook, and then selecting a product. This demo account also has 
a region field under the User object, representing East, West, and Central regions for 
analysis. 

The following list provides the name of the report and a brief description. 

Note:   

• For Crystal Reports XI, the sample reports are installed by default in the \Program Files\Business 

Objects\Crystal Reports 11\Samples\en\Reports\SalesForce directory. 

• For Crystal Reports XI R2, the sample reports are installed by default in the \Program 

Files\Business Objects\Crystal Reports 11.5\Samples\en\Reports\SalesForce directory. 

Report name Description 
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Pipeline Forecast This report shows the average order size and 
opportunity closing over time. 

Product Segmentation This report shows opportunity with parameters 
by region/reps. 

Sales by Geography This report shows sales on a map, with the 
number of open opportunities, closed 
opportunities, won opportunities, and lost 
opportunities. On the map, you can see areas 
of business high- and low-volume sales. You 
can leverage this information to help design and 
split territories. 

Sales Rep Performance This report shows sales by representative by 
region, stack rank, the performance of the 
representative, the number of deals won versus 
lost, the size of the pipe, and a regression 
analysis of sales and how they are performing 
against the norm. 

Product Performance and 
Pipeline 

This report shows product sales in each region, 
pipelines for each product, and joins between 
product, product line, and forecast. 

Campaign Segmentation This report shows people who were touched X 
times in a campaign, or it shows people in 
campaign X (but not Y) who responded to Z. 

Lead Follow up This report show leads where there was only X 
number of follow ups, and not Y number of 
follow ups. 

Lead Generation 
Segmentation 

This report shows the ratio of leads that get 
converted to an opportunity. 

Campaign Calldown This report shows multiple campaigns to stack 
rank the success of the campaigns, how many 
leads, and how much cost. 

Opportunity Exception This report shows accounts that do not have 
opportunities, accounts that have opportunities 
without products listed, and opportunities with 
product X but not product Y. 
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Accounts with or without 
Contacts 

This report shows opportunities that have 
contacts as well as opportunities that do not 
have contacts. Accounts are listed by rating, top 
10 counties, and account type. 

Accounts with or without 
Contacts - Custom 

The same report as above with extra graphical 
formatting and layout. Provides an example of 
the powerful formatting capabilities provided by 
Crystal Reports.  

Accounts with or without 
Contracts 

This report shows accounts that have contracts 
as well as accounts that do not have contracts. 
Accounts are listed by rating, top 10 counties, 
and account type.  

Accounts with or without 
Open Opportunities 

This report shows accounts that have open 
opportunities as well as accounts that do not 
have open opportunities. Accounts are listed by 
rating, top 10 counties, and account type. 

Accounts with or without 
Opportunities  

This report shows accounts that have 
opportunities as well as accounts that do not 
have opportunities. Accounts are listed by 
rating, top 10 counties, and account type. 

Accounts Exceptions 
Dashboard 

This dashboard displays accounts with or 
without opportunities, accounts with or without 
open opportunities, accounts with or without 
contacts, and accounts with or without 
contracts.  

Opportunities Exceptions 
Dashboard 

This dashboard shows opportunities with or 
without sales teams, opportunities with or 
without open activities, opportunities with or 
without contacts, and opportunities with or 
without products. 

Opportunities with or 
without Contacts 

This report shows opportunities with contacts 
as well as opportunities without contacts. 
Opportunities are listed by category, top 10 
countries, and by forecast.  

Opportunities with or 
without Open Activities 

This report shows opportunities with open 
activities and opportunities without open 
activities. Opportunities are listed by category, 
top 10 countries, and by forecast. 
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Opportunities with or 
without Sales Teams 

This report shows opportunities with sales 
teams and opportunities without sales teams. 
Opportunities are listed by category, top 10 
countries, and by forecast.   

 
 


